
Movavi Video Editor 4 for Mac
 

Don't know where to start?
Read these tutorials:

Make a video
Read this quick start guide on how to

create your first video project, start to finish.

How to remove trial restrictions
Save your video without a watermark

and use the program after 7 days.
 

More questions?
Write us an e-mail at support@movavi.com

Make a slideshow
Learn how to make slideshows

with music, titles and transitions.

 

mailto:support@movavi.com
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Removing trial restrictions
When you first start Movavi Video Editor, it will be running in TRIAL MODE. To use the program without trial restrictions,  you will need to buy the
full version and activate Movavi Video Editor.
 
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

Step 2: Open the Movavi Video Editor 4 menu and select Activate software.

Step 3: Enter your activation key and click Activate.

Activating without Internet access
If the computer you have installed Movavi Video Editor for Mac on is not connected to the Internet, you can activate the program via e-mail.
See detailed instructions
 
I bought Movavi Video Editor for Mac, but my videos already have a watermark
After you have activated the program, you can open the movie project and re-export the movie without the watermark.
How to export videos
 
 

Trial restrictions
When you first start your copy of Movavi Video Editor for Mac, it will be running in LIMITED TRIAL MODE. In trial mode, you can try out all of the
main features, but the following trial restrictions will apply:
 
TRIAL VERSION FULL VERSION

 Movavi Video Editor for Mac will stop working after 7 days  Lifetime license

 A watermark with the words ' trial version' will be added to all
exported videos.

 No annoying watermarks

 Audio files will only be saved halfway.  Free updates
   Discounts on other Movavi products and upgrades
 
To remove the restrictions, buy an activation key and use it to activate Movavi Video Editor for Mac.

Getting an activation key

You can get an activation key either from our official website or from any of our partners in your region. Please follow the steps below to buy an
activation key from the Movavi website:

http://www.movavi.com/mac-video-editor/buynow.html?asrc=vem_help
http://www.movavi.com/mac-video-editor/buynow.html?asrc=vem_help


 

 

 
Step 1: Go to the purchase page
To open the purchase page for Movavi Video Editor for Mac:
•  In the Help menu, choose Buy Activation Key, or
•  Follow the link below...

Step 2: Choose a license type
•  If you plan to use Movavi Video Editor for Mac at home, click the Buy Now button under Personal License.
•  If you plan to use Movavi Video Editor for Mac at work, in a government institution, or gain profit in any way, click the Buy Now button under
Business License.
 
After that, you will be redirected to an online store depending on your region and the available payment methods. All of our vendor partners are
secure and completely safe.
 
Step 3: Fill in your billing details
1. Choose any of the available payment methods.
2. Fill in the information required on the page.
3. Enter your valid e-mail address. This e-mail will be used to deliver your activation key.
 
Step 4: Get your activation key
After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate the program.
Activation instructions
Activating without Internet access

If you haven't received your activation key within an hour:
•  Check the Spam folder of your mailbox
•  Contact support

Activating without Internet access
If your computer is not connected to the Internet, you can activate Movavi Video Editor via e-mail.
 
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

Step 2: Open the Movavi Video Editor 4 menu and choose Activate Software.

 
Step 3: Enter your activation key and select the Activate offline option. Then, click Activate.

Step 4: In the next window, click Copy and transfer this information to a computer or device with an Internet connection.

http://www.movavi.com/mac-video-editor/buynow.html?asrc=vem_help
http://www.movavi.com/mac-video-editor/buynow.html?asrc=vem_help
http://www.movavi.com/support/contact.html
http://www.movavi.com/mac-video-editor/buynow.html?asrc=vem_help
http://www.movavi.com/mac-video-editor/buynow.html?asrc=vem_help


 

 

Step 5: When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You should
receive a reply within an hour. Copy the registration key from the reply and transfer it to the computer with Movavi Video Editor.

Step 6: Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you used
before. Then, paste the registration key into the box and click Activate.

Quick start guide
Jump to:

Creating project | Adding files | Cutting clips | Editing clips | Filters | Titles | Transitions | Saving the video
 
Step 1: Create a new project
When you open Movavi Video Editor for Mac, you will see a welcome screen. Choose Create project in full feature mode to start your video
montage.
Learn more about projects and aspect ratio

mailto:reg@movavi.com


 

 

Step 2: Add videos, images and music
On the Import tab of the Video Editor, click Add Media Files to choose the video, audio, and image files you'll be using.
 

Learn more: Adding files | Recording video | Recording audio

When you open the files, they will be placed on the Timeline: the videos and photos on the video track, and the audio clips on the audio track. To
rearrange the clips, simply drag them to the necessary position with the mouse.
 

Learn more: Using the Timeline | Working with video and images | Working with audio

Step 3: Cut videos
1. Select the clip that you want to split*.
2. Move the position marker onto the moment where you want to cut the clip. You can move the position marker both in the player or on the
Timeline.
3. Click the scissors button on the toolbar to split the video into two parts.

Learn more: Cutting video | Cutting audio
 

* Note that if you select a video clip, its audio track will also be cut, unless you
move it to a separate audio track. Learn how to work with audio on the Timeline



 

 

Step 4: Edit and enhance clips
Select the clip you want to edit and use the buttons on the toolbar to perform basic editing.

Learn more: Rotating clips | Cropping clips | Enhancing colors | Video properties | Audio properties
Step 5: Add Filters
Filters can help you change the colors in your photos and videos or add an artistic touch. To apply a filter:
1. Click the Filters button to open the filter library. To preview a filter effect, click on its thumbnail.
2. Drag the filter's thumbnail down onto a clip on the Timeline to apply it. A star icon will appear on the clip.
Learn more about filters

Step 6: Join clips with transitions
1. Switch to the Transitions tab, where you can choose animations to smoothly join the clips.
2. Drag-and-drop a transition icon in between two clips on the Timeline.
Learn more about transitions



 

 

Step 7: Add text titles
1. Click the Titles button to open the titles collection. To preview a title style, click on its thumbnail.
2. Drag the titles you like onto the top of the Timeline. The title track will appear. Place the titles where you want them to appear relative to the
other clips.
3. To change the text and edit the title style, double-click the titles clip you've just placed. The title properties panel will appear in the player, where
you can edit and move the text.
Learn more about adding titles

 
Step 8: Export the finished video
Make sure to save your work once in a while: choose Save from the File menu to save the video or slideshow project so that you can access it
later.
 
When you're done with the project, click the Export button to open the exporting options. In the Export window, choose a format you want to save
the video in, and name your video file. Finally, click Start to begin processing the video. It will be ready in a few minutes.
Learn more about saving your video

Having trouble with something?  E-mail us and we'll help you out! Our e-mail: support@movavi.com
In this guide, you will learn how to turn your photo albums into awesome slideshows complete with music and transitions. Creating a slideshow is
easy as 1-2-3 using the built-in Slideshow Wizard. Follow the instructions below to open the wizard and start making your own slideshow.
 
Create a new slideshow
•  On the welcome screen, click Slideshow wizard to open the three-step slideshow wizard.
•  Or open the File menu and choose New Slideshow.

mailto:support@movavi.com


 

 

Step 1: Add photos
Click +Files and +Folders to add photos to your slideshow. Organize and rotate your photos.
Learn more – Step 1: Add photos

Step 2: Add transitions
Click the Step 2 button to go to the next step and choose a transition style you like.
Learn more – Step 2: Add transitions

Step 3: Add music
Click the Step 3 button to go to the next step and click +Audio to add some music. Then, trim the music as you see fit and set up music beats.
Learn more – Step 3: Add music



 

 

Step 4: Add titles and effects
Click Finish to generate your slideshow. Now you can add some finishing touches like filters, titles and special effects.

Learn more:
Adding filters
Adding titles
Color adjustments
Removing black bars
 
Step 5: Save your slideshow
When you're done, click Export in the bottom right-hand corner of the window.
•  To save the slideshow as a video file, pick a video format and click Start.
•  If you want to share the video straight to YouTube, switch to the Upload online tab. There, sign in to your YouTube account, fill in the
information and click Start to save and upload the video.

Learn more:
Exporting videos
Uploading videos online

Step 1: Add photos
1. In the first step of the Slideshow Wizard, click +Files to open individual images, or click +Folders to add entire folders to your slideshow.
 
2. An Finder window will open. Choose the files or folders that you want to add.



 

 

3. Reorder your slides:
The slides will appear in the same order as you have added them. To rearrange the slides, simply click and drag them with your mouse to the
necessary position.

4. Remove unwanted photos:
•  To remove one photo, hover your mouse pointer over it and click the trash can button that appears on top of it.
•  To remove several photos, select them in the list and click the trash can button beneath the slide list.
 
5. Rotate photos
•  To rotate one photo, hover your mouse pointer over it and click the rotation button that appears on top of it.
•  To rotate several photos, select them in the list and click the rotation button beneath the slide list.

Next step: Adding transitions
Step 2: Add transitions

Using transitions, you can join your photos with cool animations.
 
1. On the left side of the Slideshow Wizard, click the button with the number 2 to proceed to choosing transitions for your slideshow.
 
2. You will see a list of transition styles. Click on the one you like to choose that style.
 
3. In the Max transition duration box, enter a time in seconds to limit the maximum length of the transitions in your project. The length of each
transition is defined by the length of the slides it is joining, and by the beat of the music that we will add in the next step.
 
Limiting transition length helps you avoid transitions that are too long.
 
* Transitions cannot be longer than any of the slides in your project.



 

 

 

Next step: Adding music
Step 3: Add music

1. On the left side of the Slideshow Wizard, click the button with the number 3 to proceed to adding music.
 
2. Add music:
 To add music, click the +Audio button and choose the audio files you want to use. If you don't have a suitable audio file, click 'Add one of our
tracks' to open the list of sample audio tracks and then click on a soundtrack in the list to add it.
The audio files will appear in the list. You can now preview and trim the audio clips.

3. Trim the audio
Click the play button to start playback.

Skip to the part where you want the audio to start and click the left bracket icon to trim the clip to this point.

Skip to the part where you want the audio to end and click the right bracket icon to trim the clip from this point.

4. Adjust slides to music beat
The Slideshow Wizard can analyze the music you've added and adjust the length of slides and transitions to fit the music tempo. Click the Yes
button in the Wizard to enable beat adjustment.
 
Then, enter the minimum slide duration to prevent slides from changing too fast.



 

 

5. Finish your slideshow
Click the Finish button in the Wizard to start processing your slideshow. When the slideshow is ready, click OK to close the Wizard. You can now
see your slideshow on the Timeline. Here, you can manually edit slides, or proceed straight to saving the slideshow.

Next step: Adding titles and effects
Step 4: Add titles and effects

When you've completed the Slideshow wizard, your slideshow will be ready on the Timeline. From here, you can proceed to saving it as a video file
or add some more cool effects.
 
Add filters
1. Click the Filters button on the left sidebar to open the filter collection.
2. Pick a filter you like and drag it onto the clip you want to apply it to.
Learn more about filters

Add titles
1. Click the Titles button on the left sidebar to open the text title collection.
2. Pick a text style you like and drag it onto the title track at the top of the Timeline.
3. Double-click on the title clip to change the text and edit the font, color, and other properties.
4. Click Apply in the editing panel above the player.
Learn more about titles



 

 

Crop photos
1. Select the photo you want to crop.
2. Click the Crop button on the toolbar.
3. A frame will appear in the player. Move the frame to the part of the screen you want to keep.
4. Click Apply on the Tools panel on the left.
Learn more about crop

Adjust photos
1. Select the photo you want to adjust
2. Click the Color Adjustments button on the toolbar.
3. Choose the adjustments that make your picture better.
4. For more options, click Manual Adjustments and adjust the colors manually.
Learn more about color adjustments

Step 5: Save your slideshow
1. In the bottom right-hand corner of the window, click Export. The export settings window will open.



 

 

2. In the Export window, open the list at the top and choose a format for saving your slideshow.
 
3. Click Browse to choose where you want to save your slideshow file and name your slideshow in the File Name box.
 
4. Finally, click Start to save your slideshow as a video file. This may take a few minutes if the slideshow is very long.

Creating and managing projects
A Movavi Video Editor for Mac project is a file in the *.mepx format that contains your work on creating a video. A project stores the locations of
each media file used in the project, as well as the edits, special effects, and settings that you use as you make your movie.
 
Creating a project
To create a new project, open the File menu and choose New Project. Then, choose Create project in full feature mode if you want to make a
movie, or choose Slideshow wizard if you want to make a quick slideshow.
Creating projects
 
Saving projects
To avoid losing your editing progress, make sure to save your project every once in a while. To save a project, open the File menu and choose
Save Project.
Saving projects
 
Opening projects
To open a previous project, open the File menu and choose Open. Then, find the project file and continue working on your movie.
Learn how to open projects
 
Media use
When you add files to a project, Movavi Video Editor for Mac uses the original file for reference as you edit the movie. To save your disk space,
Movavi Video Editor for Mac does not make copies of the files, but rather remembers the location and name of the original file, so if you move or
delete the files, they will also disappear from the project.
Learn how to find missing files
 
Because all of your editing work is done in the project, your original files are not edited in any way, and you do not need to make reserve copies.
 
How can I play my project?
Project files cannot be viewed in a regular video player, but can only be opened with Movavi Video Editor, Movavi Screen Capture Studio, or
Movavi Video Suite. To view the finished work in a player, you need to first export your movie to a common video format.
Learn how to export your project

Creating a project
1. Open the File menu and choose New Project.
2. A welcome screen will appear. Click Create project in full feature mode to start making your movie.

•  If you want to make a quick slideshow, click Slideshow wizard on the welcome screen.
•  If you want to set up your project's size and other settings before starting, click Advanced project setup.



 

 

That's it! You can now start creating your movie.
 
Advanced project setup
If you want to set up the project's frame size before starting, click Advanced project setup on the welcome screen. Then, specify the necessary
settings and click OK to start working on your project.

    
Resolution
The resolution is the width and height of your video in pixels. The higher a video's resolution, the more detail and quality of the original video it can
retain. Choose your project's resolution based on the videos and images that you plan to use in it.
 
You can choose from one of the resolution presets, or manually enter the width and height into the corresponding boxes.

Aspect ratio
A video or image's proportions are called the aspect ratio. It is the ratio of the video's width to its height, and is shown in parentheses next to the
project's resolution. While the most widespread aspect ratio is 16:9, others are also popular. Choose your project's aspect ratio depending on the
videos and images you plan to use in it.
 
If the project's aspect ratio is different from that of the files, you may see black bars around the edges of the frame. Learn how to fix black bars



 

 

 
Adding 4:3 photos to a 16:9 project and vice versa

 
Framing
When you add videos and photos to your project, they are scaled to fit the project's resolution and aspect ratio. Framing, or resize method, defines
how photos and videos will be placed inside the project's frame. This is especially important if you are using photos and videos that have different
aspect ratios and want to avoid black bars on the screen.
 

•   Letterbox - the photos and videos will retain their original proportions, and will be resized to fit entirely inside the frame. Leftover space in
the frame will appear as black bars.
 
•   Stretch - the photos and videos will be resized to fit inside the frame as best as possible, and then stretched to fill the remaining space.
This allows to fill the entire screen without black bars, but it may distort objects in the photos.
 
•   Crop - the photos and videos will be resized in such a way as to fill the entire frame without changing their proportions at the expense of
cropping away the edges. This allows to fill the entire screen nicely, but some parts around the edges will not be visible.
 

FPS
The number of frames per second is the number of shots that a camera takes each second to make a video. Most cameras shoot video at
around 24 frames per second. However, some cameras can shoot high-speed video that you can use to make slow motion clips. If you plan on
using high-speed videos, choose the FPS that matches the video. If you're using regular videos, leave the default FPS.
 
Sample rate
Just like digital video is made up of individual frames, digital audio is made up of tiny audio samples. Audio's sample rate defines how many of
these samples are taken in a second and is measured in Hertz (Hz). This affects audio quality. The default option, 44100 Hz, is suitable for most
projects.
 
Channels
This affects the number of channels in the project's audio. You can choose from mono (one channel) and stereo (two channel) sound, but stereo
is usually best for most projects.
 
Project settings
You can also change these settings later by clicking the pencil icon at the bottom of the window: .

See also:
Saving your work
Project settings
Exporting your movie

Project settings
Project settings affect your entire project and define how different kinds of videos, photos, and audio files are composed into your finished video.
You can set up your project's video and audio settings both when creating the project and at any other time.
 
Opening project settings
When creating a project:
When you create a new project or launch Movavi Video Editor for Mac, you will see a welcome screen. To change the settings before starting the
project, click Advanced project setup.

During editing:
•  On the bottom panel of Movavi Video Editor for Mac, find the pencil icon next to the information about your project. 
•  Open the Edit menu and choose Project Settings.
The Project Settings window will open.



 

 

Video settings
The video settings apply to all videos and photos used in the project. When you import the media files, they will be scaled to fit inside the selected
frame size according to your settings. 
 
Resolution
The frame size or resolution determines the videos width and height in pixels. Open the Resolution list to select from the most common
resolutions. For your convenience, each resolution is marked with its respective aspect ratio. Ideally, the frame size should match the resolution of
the videos and photos you plan to use in your project, and should not exceed the resolution of the largest video. Smaller resolutions allow you to
make the output video smaller and thus save your disc space, however, this will sacrifice some video quality due to downscaling.

Frame Size Aspect Ratio
320x240 4:3
640x480 4:3

1280x720 16:9
1280x960 4:3

1920x1080 16:9
1920x1440 4:3

Aspect ratio
The aspect ratio is the ratio of the video or photo's width to its height. The most commonly used aspect ratios are 4:3, used generally for analog
TV and in many old movies, and 16:9, the standard resolution for widescreen digital video.

A relative comparison of aspect ratios
 

When you add videos and photos to the project, they will be scaled to fit the specified frame size. If you add media files with an aspect ratio
different from that of the project, you may see black bars appear on the sides of the video. Furthermore, if you add low-quality videos to a project
set up to a high resolution (frame size), the small video may be stretched to fit the frame and thus may appear pixellized. For best results, we
recommend setting the frame size and aspect ratio to match all or most of the videos and photos you are planning to use.

 
Examples of black bars appearing when importing videos with a different aspect ratio.

 
If you cannot find the necessary frame size in the list, you can manually enter the width and height into the respective boxes of the Project
Settings window. Note the button with the link icon to the right of the boxes. It allows you to maintain existing proportions when entering new

values:   – the proportions are constrained, allowing you to set a larger or smaller frame size without changing the aspect ratio;  – you can
freely enter the width and height with any proportions. Simply click this button to toggle the two states.
 
Framing
Choosing a framing method can help you manage how all of your videos and photos are resized to fit inside the frame size you've set. This is
especially important when the aspect ratio of some videos and photos does not match the aspect ratio of the project and you need to get rid of
the black bars. There are three resizing options available:
 
Letterbox – the video will be resized to fit inside the frame entirely. This method allows you to keep the whole video inside the frame without
distortions, but may place black bars around the video.



 

 

Stretch – the video is fit entirely inside the frame and then stretched on one axis in such a way as to fill the entire frame without leaving black
bars. This allows you to cover the entire frame, however, the objects in the video may appear horizontally or vertically distorted.

Crop – the video will be resized to be slightly larger than the frame, cropping the parts that do not fit inside it. This allows to cover the entire area
of the frame without distorting any of the objects inside the video or without leaving black bars, however, this may not suit some clips where
important objects are near the edge of the frame.

Audio settings
Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default sample
rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music tracks.
 
Channels
Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording
music; mono sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally preferred
number of channels, however, some mobile devices record sound only in mono mode.

 

See also:
Creating a project
Saving projects
Opening projects

Saving projects
A project stores all the work on your video. You can save the project for finishing your video later, or restore your work if you need to edit
something after you've finished.
 
Saving the project
1. Open the File menu and choose Save Project.
2. You will be asked to enter a name for the project. Your project files should be stored in the /Movies/Movavi Video Editor/Projects folder of your
user. 
3. Click Save to confirm saving.

Later, you can open this project to continue working on your video.
 
Restoring work from an autosave
If your computer malfunctions and you cannot save the project, some of your work may be restored using an autosave file. Simply rename the
"autosave.mepx" file and open in in Movavi Video Editor for Mac to continue working on your project.



 

 

See also:
Finding missing files
Project settings
Exporting videos
 

Opening projects
Open a project to continue working on your video.
 
Where are my projects located?
By default, your projects are saved to "/Movies/Movavi Video Editor/Projects", but you can save your projects anywhere else you like.
 
How to open a project
A: Find your project in Finder and drag it onto the Video Editor window.
 
B: Find your project in Finder and double-click it to open it in the Editor.
 
C: Click Open Project on the welcome screen. Then, locate the project file in the Finder box and click Open.
 
D: Open the File menu and choose Open Project. Then, locate the project file in the Finder box and click Open.
 
How to change where projects are saved
1. Open the Movavi Video Editor menu and choose Preferences.
2. Click the Files tab.
3. Find the Save project files to box and click the button next to it to choose a different folder for storing your projects.
4. Select the folder you want to use and click Select Folder. 

Finding missing files
When you open a previously created project, you may see a message saying that a file is missing from the project. This may happen if one of the
files used in the project has been moved somewhere else or deleted from disk. 

 
•  If the file was moved elsewhere, click the Browse button and locate the file in the Finder window. After that, you can continue working on the
project as usual: the file will be restored in its place on the timeline, as well as any other changes you have made.
•  If the file was deleted or you no longer wish to use it in the project, click Skip to open the project without the missing file.
•  To cancel loading the project, click Cancel.
 



 

 

Note that you can only use original files located in the /Movies folder of your user.

Why is this happening?
In order to save disk space, Movavi Video Editor for Mac does not copy the files you add to the project, but rather remembers their location on
disk. Therefore, if you move or delete the original files, it will no longer be able to use them as reference.
 
Where should I store the original files?
We recommend you to store the original photos and videos for your projects in the User/Movies folder.
 
 

Adding media files
To begin working on your video project, you will first need to add some media files to the Editor.
 
Open the Import tab
The Import tab contains options for opening and creating media. To open it, click the Import button in the upper left-hand corner of the Video
Editor window.

Step 2: Go to the My files section
In the left part of the Import tab, you can switch between adding your own media files or using built-in clips. Click on My files to show file import
options.

Step 3: Open files
1. Click Add Media Files.
2. A Finder dialog box will open. Locate your files or folders and click Open.



 

 

If you want to add the entire contents of one or several folders, click Add Folder, select the folder(s) you want to use and then click Select Folder
to add the files.

 
Step 4: Arrange the files
Once you've added the files, they will appear on the Timeline at the bottom of the window. The Timeline allows you to arrange the clips in the
order you want. The clips' position relative to the time ruler at the top of the Timeline determines when it will appear in the finished video. To
reorder the clips, select the clips you want to move and then drag them to the new position on the Timeline.
Learn about using the Timeline

Moving a clip on the Timeline

See also:
Working with video
Working with audio

Recording video

Follow the steps below to record video from a camera that's connected to your computer.
 
Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working
correctly.
 
Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and frame rate. A larger
resolution will be able to retain better quality, however, the video file size will be larger. A higher frame rate is necessary for recording motion, while
static scenes can be captured with a lower frame rate.
 



 

 

Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.

Step 5: (Optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them somewhere else, click the folder

button  under 'Save files to' and choose a different location.
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file name
template. 
 

Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button  on the right.
 
Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.
 
Step 9: When you're done, click Back to editing at the bottom of the window. The captured files will be added to your project's Timeline. Also,
they are saved to disk in case you want to use them later.

Recording audio
After you've added some videos and photos to the Timeline, you can record audio from a microphone or any other recording device.
 
Step 1: Set up recording
1. On the toolbar, click the microphone button to open audio recording options.
* There must be at least one clip on the video track.



 

 

Step 2: Prepare for recording
1. In the Audio device box, choose the device you want to use.
 
To record from a microphone: choose your preferred microphone or webcam microphone. If you don't see the device in the list, try reconnecting
it to your computer.
 
To record audio from the computer: select Speakers from the list to record any music, alerts, or other sounds playing on your computer.
 
2. (Advanced) In the Audio quality box, choose the sample rate and number of channels that you need.
 
3. Set the volume level you want to use in your project.

 
4. On the Timeline, place the progress marker to where you want the recording to begin.

 
Step 3: Record sound
1. When you're ready, click Start Recording. You will be given a 5-second countdown.
 
2. The video will start playing simultaneously with the recording. This way, if you're recording a voice-over, you will be able to use the video as a
visual aid as you speak.
 
3. When you're done, click Stop Recording. The recorded audio clip will already be on the Timeline, as a linked audio clip.
* The recording will stop automatically if it reaches the end of the video track.

Importing AVCHD video

audio_tracks.htm#linked_audio


 

 

Follow the steps below to import previously recorded videos from an AVCHD camera.
 
Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera. Make sure that the
system recognizes the device and that it is working correctly.
 
Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, select your AVCHD camera.

 
Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't need.

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere else, click the folder

button  under 'Save files to' and choose a different location. 
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file name
template. 
 
Step 7: Click Add files to the Editor to start copying the files. This may take a while depending on the size of the videos.



 

 

 
 

Using built-in media
Movavi Video Editor for Mac comes with an extensive collection of built-in media that you can use in your projects for free.
 
Step 1: Open the Import tab
Click the Import button in the upper left-hand corner to open the media options.

Step 2: Choose a media type
On the left side of the Import tab, you can switch between using your own media files and adding clips from the stock collection.
 
•  Sounds – fun sound effects and audio samples to make your videos more expressive.
 
•  Music – instrumental tracks for your background music.
 
•  Sample video – video clips that you can use as intros, overlays, and animated backgrounds.
 
•  Backgrounds – image backdrops for your titles and transparent clips.

Step 3: Add the clip to your project
To use a stock clip in your project, pick a clip you like and drag it onto the Timeline.



 

 

I can't use the stock media clips
The stock media clips are usually downloaded when you start Movavi Video Editor for Mac for the first time. If you don't have an Internet
connection, the stock media will be unavailable, but the clips will be downloaded the next time you connect to the Internet. Once downloaded, the
clips will be stored in your "/Movies/Movavi Video Editor/Media Content" folder.

 
 
 
 
 

File information
Find the file's location
To find the location of the clip's original file, right-click on the clip on the Timeline and choose Show in Folder from the menu.

See a clip's media information
To see a clip's media properties, right-click it on the clip Timeline and choose File Information from the menu.

A small File Information window will appear. Here, you can find the resolution, aspect ratio, and other properties of the original file. Knowing
certain information about a clip will allow you to better understand which settings are best for your videos.

Using the Timeline
The Timeline, located in the bottom part of the window, is the working area that allows you to organize and edit the clips. The Timeline consists of
several tracks, which are all synchronized to a single time scale at the top, which indicates the time of the project. 



 

 

 
Timeline tracks
Your clips are arranged on tracks by media type:

•  Titles track – contains text and callout clips.
•  Overlay track – contains videos and images that are shown on top of other clips.
•  Video track – contains videos, images and the transitions between them.
•  Linked audio track – contains audio clips that are synchronized with the video track.
•  Independent audio track – contains audio clips that are not linked with the video track, such as background music.

Learn more about timeline tracks
 
Arranging clips
By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your
mouse and drop them onto the desired position. To select multiple clips, use ⌘+click or click and drag to draw a selection on the Timeline.

Zooming the Timeline
To change the zoom level of the Timeline, drag the Scale slider at the bottom of the window. Move the slider left to zoom out, and move the slider
right to zoom in on the Timeline.

Position marker
The position marker defines the currently selected point on the Timeline. There are two position markers: the orange line on the Timeline,
stretching down from the time scale all the way through all of the tracks, and the position marker on the progress bar of the player. Both denote
the current position relative to the whole project and show identical time.
 
The timestamp in the player displays the currently selected time from the beginning of the project.
Learn more about previewing clips

See also:
Creating overlays
Adding titles
Adding callouts

Timeline tracks
The Timeline is made up of several tracks, one for each media type, that allow you to arrange the clips in chronological order; mixing and joining
the clips together to create your unique video.
 



 

 

Video track
The video track contains video clips and their attached audio, images, and transitions between clips.
•  You can link audio and titles to video and image clips so that they will stay in sync as you edit the project.
•  You can rotate, adjust, and use other tools on video and image clips on this track.
•  You can apply filters to video and image clips on this track.

 
Linked audio track
The linked audio track contains audio clips that are linked to video clips. At the beginning of each linked clip, you can see a blue line that connects
it to the video or image clip it is linked to. When you move, split, or delete the clip on the video track, the linked audio clip will also be edited with it.
This is useful if you've synchronized the clip's audio to the video track and don't want it to change as you edit your project.
•  The linked audio track is hidden at first, until you drag an audio clip between the independent audio track and the video track.
•  You can edit the audio clips' volume and speed in the Tools tab.
•  You can have several audio clips playing simultaneously. To do that, simply place them one under the other.
 
Independent audio track
The separate audio track contains audio clips that are not dependent on clips on the video track. This track is good for background music.
•  You can edit the audio clips' volume and speed in the Tools tab.
•  You can have several audio clips playing simultaneously. To do that, simply place them one under the other. 
Learn more about audio tracks

Titles track
The titles track contains text clips that will appear on top of all other clips.
•  You can change the titles' duration on the Tools tab, or by dragging the edge of the title's clip on the Timeline.
Learn how to place titles
 
Overlay track
The overlay track contains additional video and image clips to create special effects like Picture in Picture or Chroma Key.
•  Clips on the overlay track are linked to clips on the video track and will stay in sync as you edit the clips.
•  You can apply filters and use all of the Tools to edit the clips on this track, just like any other video or photo.
•  You cannot join clips on the overlay track with transitions.
Learn about using overlays
How to create a chroma key video
 
To select all clips on a single track, click the area with the track's icon to the very left of all clips.

Hiding and muting tracks
If you want to see how your project looks without some clips, you can disable separate clips or entire tracks.
 
Hiding clips
To hide a clip from view, right-click the clip and choose Hide Clip from the pop-up menu. The clip will not appear in the player or on the finished
video until you re-enable it.

 
Muting clips
To disable a clip's sound, right-click the clip you want to mute and select Mute Clip from the pop-up menu. The clip will not play in the player or on
the finished video.



 

 

Disabling tracks
To hide an entire track from view, click the eye icon  to the left of the track you want to hide.
 
To disable the sound for an entire track, click the speaker icon  to the left of the track.

 
Previewing clips

Use the player in the upper right-hand part of the window to preview your project.
 
Playing the video
1. Move the position marker to where you want to start playback.
2. Click Play or press the Space Bar key. 
3. Click the Pause button or press the Space Bar again to pause playback.

Position marker
The position marker shows which part of your project is currently shown in the player. There are two position markers: one on the player's
progress bar, and another on the Timeline. Both of them move simultaneously and you can use whichever you like.

To move the position marker, do any of the following:
 
•  Click anywhere on the Timeline to move the position marker to that position.
 
•  Drag the position marker (either on the Timeline or in the player). For higher precision, try zooming in on the Timeline.



 

 

 
•  To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds.
 
•  To move precisely from frame to frame, use the Previous frame and Next frame buttons in the player. This will move the position marker
exactly one frame backward or forward.
 
Working with two monitors
If you have more than one monitor, you might want to detach the player into a separate window to have more room for editing. To do that, click
the Unpin player button under the player:

 
The player will then open in a separate window. When you want to return the player back into the main window, click the Pin player button in the
detached player or close the player window.

How to undo actions
It's okay if you make a mistake or change your mind while editing videos because almost any action can be reversed!
 
•  Click the Undo button on the toolbar or press ⌘Z to cancel an action.
•  If you've cancelled an action but want to return to it, click the Redo button or press ⌘⌘Z.

 
...
 
 

Working with video and images
After you've added some videos and images to your project, they will appear on the video track of the Timeline, where you can move and arrange
them into a movie. Next, it's time to edit and enhance the clips.
 
Cut video clips
On the Timeline, select the clip that you want to cut and move the position marker onto the moment where you want to split the clip. Then, click
the scissors button on the toolbar to split the clip into two parts.

Edit videos and images
Photos and videos aren't always perfect from the beginning. Use the buttons on the toolbar to fix and adjust the clips.
 

Learn more: Rotating video | Cropping video | Color adjustments | Volume | Speed | Reversing video | Image duration | Fades | Video properties



 

 

Picture in picture and overlays
To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of the Timeline to create
an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on the video.
Learn more about overlays

Picture and picture, side by side overlay modes.
 
Removing black bars
Some videos and photos may have black bars around them in the player. This can happen because the clip's proportions are different from the
project, for example, if you add a vertical video. To fix this, you can crop the video or use the special Vertical video fill filter.
Learn more about removing black bars
 
Creating freeze frames
A freeze frame is a still shot inserted in the middle of a video for dramatic effect. You can use the freeze frame to emphasize a very fast
movement or pause the action while you give additional information.
Learn more about freeze frames

Before and after adding a freeze frame
Video tracks

When you add videos or photos to your project, they are added to the video track of the Timeline. From there, you can rearrange the clips and
move them to other tracks.

Video track
The video track contains your videos with their built-in audio, photos and the transitions between them. To arrange clips on the video track, simply
drag them with your mouse.
 
•  You can link audio and titles to video and image clips so that they will stay in sync as you edit the project.
•  You can rotate, adjust, and use other tools on video and image clips on this track.
•  You can apply filters to video and image clips on this track.
•  You can also add titles to the video track, if you want to show them against a solid black background.



 

 

 
Overlay track
The overlay track is used to show a photo or video on top of the main video track. You can use overlays to show split screen footage or create a
chroma key effect.
 
To create an overlay, select a clip on the video track and drag it up, onto the overlay track. By default, new overlays are created in picture and
picture mode. To change the overlay mode, double-click the overlay clip and choose a mode in the control panel on top of the player.

Overlay modes: picture in picture, side by side, cover
 
 
•  You can add filters and any special effects to the overlay track.
•  You cannot use transitions on the overlay track.
•  Every overlay clip is linked to the corresponding clip on the video track.
Learn more about overlays
 
Linked clips
Clips on the titles, linked audio, and overlay tracks are all linked to a clip on the video track. You will see a line joining the beginning of the linked
track to a corresponding position on the video track. Whenever you move a clip on the video track, any clips linked to it will also move with it. This
allows you to keep clips synchronized as you edit the video.

Linked overlay, titles, and audio tracks
Cutting video

Using Movavi Video Editor for Mac, you can easily split videos into parts and cut out fragments with the Splittool. You can find it on the toolbar of

the main window, marked with a scissors icon:  

Splitting video into parts
Step 1: Select the clip that you want to split.
Step 2: Move the position marker to the moment where you want to cut the clip.
Step 3: Click the Split button on the toolbar.
Note that if the clip has linked audio, the audio clip will also be split.

https://youtu.be/RbAzdYxoV-M
https://youtu.be/RbAzdYxoV-M
using_the_timeline.htm#position_marker
audio_tracks.htm#linked_audio


 

 

Cutting out fragments
Step 1: Cut the clip at the beginning of the unwanted fragment

1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to catch the
moment precisely.
3. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

 
Step 2: Cut the clip at the end of the fragment

1. Select the second clip the you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the Split button again. The fragment should now be in a separate clip.
 

Step 3: Delete the unwanted fragment
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key to remove this clip. The clip will be removed, and the remaining clips on the Timeline
will move to close the gap.

 
Trimming videos
If you only need to cut off some parts at the beginning or at the end:
Step 1: Place your mouse pointer over the edge of the clip.
Step 2: Click and drag the edge towards the center of the clip to trim the clip to the desired length.

For more precise navigation:
•  Use the arrow keys to jump to the beginning of the previous or next clip on the Timeline.
•  Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second
forward or back.
•  Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: ⇧⇧⇧ and ⇧⇧⇧.
•  Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the ⇧⇧ and ⇧⇧ keyboard shortcuts.

 
Rotating video

Nobody likes vertical videos! But don't worry, in just a few clicks, you can turn any photo or video around without having to crane your neck.
 
Rotating by 90 degrees
1. On the Timeline, select the clip you want to rotate



 

 

2. Click the Rotate button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate the video more.

Fixing horizon level
1. On the Timeline, select the clip you want to rotate.
2. Click the Crop button on the toolbar to open the Crop tool above.
3. In the Crop tab, use the Angle slider to slightly rotate the clip inside the frame, until the horizon is level with the guides in the player.

Cropping video
Cropping a video can help you remove black bars, cut away the edges of the video, or permanently zoom in onto an object inside the frame.
 
Step 1: On the Timeline, select the clip you want to crop.
 
Step 2: Click the Crop button on the toolbar. The Crop tool will open in the Tools tab, and a cropping frame will appear inside the player.

Step 3: In the player, set the frame so that the parts you don't want are outside it.



 

 

Use the options in the Crop tool on the left to modify the frame:
 
Constrain proportions: by default, the frame will have the same proportions as your project. If you want to change the proportions, deselect the
Constrain proportions option. However, note that black bars may appear around the video afterwards if the video's proportions are different from
the project's.
 
Angle: use the Angle slider to rotate the crop frame. This way, you can fix the horizon level.

Step 4: Click Apply in the Tools tab. A star  icon will appear on the clip once you've applied cropping.
 

Removing crop
To remove Crop or any other effect, do any of the following:

•  Click the star  icon on the clip to show the list of applied effects and filters. In the list, select Crop and click the Remove button to discard the
effect.
•  In the Tools tab, you'll see a checkmark next to Crop. Click the circle with the checkmark to remove the effect.

Cropping all clips
Step 1: Open the Edit menu and choose Project Settings to edit your project. The Project Settings window will open.
 
Step 2: In the Resize Method box, choose Crop.
 
Step 3: Click OK. All the project's clips will be automatically cropped to the project's frame size.



 

 

Color adjustments
If the original videos look bleak and not vibrant enough, you can use the automatic adjustments to make the colors look more vivid. If that isn't
enough, you can always use manual adjustments to correct the colors.
 
Step 1: Select clip
On the Timeline, select the clip that you want to adjust.
 
Step 2: Open color adjustments
On the toolbar, click the color adjustments button to open the adjustments in the Tools tab.

Step 3: Use auto adjustments
Under Color Adjustments, select the adjustment options that make the selected clip look nicer. The changes will be applied instantly. The Magic
Enhance option will automatically determine the best brightness and contrast balance.

Step 4: (Optional) Use manual adjustments
Click the Manual Adjustments button to show more color control options. Here, drag the sliders to fix the brightness, saturation, hue, and other
properties. To go back to the simple options, click the Auto Adjustments button underneath the sliders.



 

 

Once you have used the adjustments, the clip will be marked with a star icon, denoting applied tools or filters: 

Video volume
This section explains how to manage the volume of video clips. To change the volume of audio clips, refer to the Volume levels section.
 
Step 1: On the Timeline, select the video that you want to edit.
 
Step 2: Click the Clip Properties button to open the tools for the selected clip.

Step 3: Drag the Volume slider to set the volume for the selected clips.100% is the original volume. To mute the clip, drag the slider down to 0%.

 
Video speed

With the Speed tool, you can speed up or slow down a video or audio clip. This can be useful if you're working on a music video and you want the
video to match the tempo of the music.
 
Step 1: On the Timeline, select the clip you want to edit.
•  Note that slowing down videos works best on videos with a frame rate of 60 FPS (frames per second) and above.
•  You can also change the speed of any audio clip.
•  If you modify the speed of a video with built-in audio, the audio speed will also be changed.
 
Step 2: Click the Clip Properties button to open the editing tools for the selected clip.



 

 

Step 3: Drag the Speed slider to set the necessary video speed, where 100% is the video's original speed.

You can see the current length of each slide right under its preview on the storyboard. If you've changed video speed, the video clips will be
marked with a speed icon:

Reversing video
Reversing the video will play the clip and its audio backwards. You can combine reversing the video with increasing speed and the VHS filter to
create a cool rewinding effect.
 
Step 1: On the Timeline, select the clip that you want to reverse. You can reverse both video and audio clips.
 
Step 2: On the toolbar, click the Clip Properties button to open the properties for the selected clip.

Step 3: In clip properties, select the Reverse option.



 

 

When you apply reverse, the clip will appear with a reverse icon on top of it:

Changing image duration
By default, all images will be shown for 4 seconds each. To change the duration:

 
Step 1: On the Timeline, select the image clip that you want to edit.
 
Step 2: Click the Clip Properties button to open the tools for the selected clip.

Step 3: In the Duration box, enter the new length of the image. Use the following format: hours: minutes:seconds.milliseconds. Changes will be
applied instantly.

You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip appears
on the Timeline, the longer it will play in your movie or slideshow.

Fading video
In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading simultaneously
with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 



 

 

Step 2: Click the Clip Properties button on the toolbar. The clip properties will open in the Tools panel above.

Step 3: Set the fade length using the sliders on the Video tab.
 
Fade in – how long in seconds it will take to fade in to full opacity at the beginning of the clip.
 
Fade out – how long in seconds it will take to fade out from full opacity at the end of the clip.

See also:
Adding transitions
Fading audio
 

Video properties
To open the clip properties for a video or image, select the clip on the Timeline and click the Clip Properties button on the toolbar.

The Tools panel will open on the Video tab, where you can edit the following:
 
Volume — Sets the volume of the clip's built-in audio.
Only for video clips with built-in audio.
 
Normalize — Makes the quiet parts of the built-in audio louder.
Only for video clips with built-in audio.
 
Speed — Makes the video play faster or slower.
Only for video clips.
 
Reverse — Plays the video backwards.
Only for video clips.
 
Opacity — Affects the visibility of videos and images on the overlay track. Lower the clip's opacity to make it more transparent.
Only for clips on the overlay track.



 

 

 
Duration — Sets the precise length of the image clip.
Only for images.
 
Fade in — The video fades in from black in the time you set. Any built-in audio will also fade in.
For any clips.
 
Fade out — The video fades out to black in the time you set. Any built-in audio will also fade out.
For any clips.

See also:
Audio properties
Video volume
Video speed
Reversing video
Changing image duration
Fading video

Adding overlays
Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect, add a
logo or watermark, or insert a short clip without cutting the main video. Also, you can use overlays with the Chroma key tool.
 
Before you start:
You'll need to add both the main video (the video that will be the bottom layer) and the overlay video or image to your project. You can use images
in PNG format to add transparent logos.
 
Step 1: Place the overlay clip
1. Select the clip that you want to make an overlay and drag it up, towards the top of the Timeline.
2. Drop the clip onto the overlay track, where you want it to be shown relative to the main video track.
Note that a blue line now connects the overlay clip to the main clip. This means that the overlay clip is linked to the main clip: if you move, cut, or
delete the main clip, the overlay clip will also be edited.

Step 2: Edit the overlay
1. Double-click the overlay clip to set it up. An options panel will appear in the player.
2. Open the drop-down box on the overlay panel and choose how you want it to appear on the video: Picture in picture, Side by side, or Cover.

Picture in picture
This is the default overlay mode. Using picture in picture mode, you can show the overlay video over any part of the screen.
1. Choose Picture in picture mode from the drop-down box.
2. In the player, move the overlay to where you want it to appear in the frame.
3. To resize the overlay, drag at its corners.
4. Deselecting the Constrain proportions option will allow you to resize the overlay to any proportions, but a drastic change in proportions may
make the overlay look distorted.



 

 

Picture in picture overlay
 
Side by side
1. Choose Side by side mode from the drop-down box.
2. Use the buttons on the panel to choose how you want to align the two videos: 

Side by side overlay
Cover
Cover mode can be used for a short insert into the main video without having to cut it. While the main video (and audio!) is playing, the overlay clip
will appear on screen for the duration of the overlay clip.
 
If you want to replace a video's background using the Chroma key effect, use Cover mode to place the foreground on top of the new background.
Learn how to use Chroma key. 

Cover overlay (the main clip is hidden)
 
Step 3: Apply the changes
After you've set up the overlay, click the Apply button on the overlay options panel.
 
Step 4: Overlay clip tools
In the Tools panel on the left, set up the overlay's properties:

Volume: if you have several video clips playing simultaneously, you might want to mute one of the clips. To do that, click the mute  button, or
use the slider to lower the volume.
 
Opacity: if you want to make the overlay more transparent, lower its opacity, and the main video track will be seen through it.
 
Fade in / Fade out: while you can't use transitions on the overlay track, you can fade in the clip to make it appear smoothly. Set the slider to the
time it should take for the clip to appear.

 

See also:
Replacing video background with Chroma key
Using the Timeline



 

 

How to remove black bars
Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black bars around them.
You can remove black bars from videos using one of the ways below.

 
Fill empty spaces
Using a special filter, you can fill the black bars with blurred parts of the video. This allows you to keep the entire video on screen and make it
more pleasant to view.
1. On the Timeline, select the clip with black bars around it.
2. Click the Filters button to open the Filters tab.
3. Find the Vertical video fill filter in the Adjustments group and drag it onto the clip.
Learn more about filters

Manual crop
If black bars appear only on one or several clips, you can cut off the edges to make the video fit better inside the frame.
1. On the Timeline, select the clip with black bars around it.
2. On the toolbar, click the Crop button.
3. A frame will appear in the player. Set this frame on the part of the video that you want to keep. Parts that are outside the frame will be cut off.
4. In the Tools tab on the left, click Apply to accept the changes.
Learn more about crop

Automatic crop
If all or most of the clips have black bars around them, you can change the project's settings to either automatically crop all videos or change the
project's proportions.
1. On the bottom panel, click the pencil icon next to Project settings: . The Project Settings window will open.
2. In the Framing box, choose Crop.
Hint: If all of your photos have similar proportions, try using a different resolution.
3. Click OK to accept the changes. The videos will now be automatically cropped.
Learn more about project settings



 

 

Creating a freeze frame
A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to
emphasize a moment or create a pause to explain things to the viewer.
 
Step 1: Choose a frame
Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous frame
and Next frame buttons under the player.

Step 2: Create freeze frame
Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.

 
Step 3: Set duration
By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.
Learn about changing image duration

Adding a watermark
Adding a watermark to your videos will protect your ownership even if it's shared all over the Internet. You can add an image overlay with your
own watermark or logo, or make a new one using text.
 
Image watermark



 

 

Step 1: On the Import tab, click Add Media Files and add the image or video that you want to use as the watermark. For the best look, use
images with transparent areas.
 
Step 2: Drag the watermark clip up to the overlay track to make it appear on top of other videos.

Step 3: Double-click the watermark clip to edit the overlay. Move and resize the overlay in the player and then click Apply when you're done.
 
Step 4: To change the opacity, click the Clip Properties button and use the Opacity slider.
 
Step 5: To make the watermark show over the whole length of the video, enter your project length into the Duration box, or drag the right edge of
the overlay clip until the end of the video track.

Text watermark
Step 1: Click the Titles button on the left and pick a nice title style for your watermark.
 
Step 2: Drag the titles you like onto the beginning of the Titles track at the top of the Timeline.

Step 3: Double-click the titles and enter your watermark text. Pick a cool font and color on the panel above the player. Click Apply when you're
done.
 
Step 4: To make the watermark show over the whole length of the video, drag the right edge of the text clip until the end of the video track.
HINT: If your movie is long, zoom out on the Timeline to make changing clip length easier.
OR: Double-click the text clip to enter text editing mode and enter the length into the Duration field. You can find the length of your whole
project at the bottom of the window.



 

 

Applying filters
Using filters you can alter the mood of the video, make an old movie, overlay cool flying objects, and more.
 
Step 1: Open the Filters tab
Click the Filters button to open the filters collection. Click on a filter's thumbnail to see its preview in the player. If you're looking for a specific filter,
you can enter its name into the search box.

Step 2: Find a filter you like
•  On the left, you will see groups of filters. Click on a group to see the relevant filters.
•  If you're looking for a specific filter, enter its name into the search box under the group list.
•  If you really like a filter, click the heart icon to add it to the Favorites group. 

Step 3: Apply the filter
When you've found a filter you like, drag its thumbnail onto the clip you want to apply the filter to.



 

 

Once you've applied a filter, a star icon will appear on the clip, denoting applied filters and tools.

Clip with an applied filter
Removing filters
1. Click on the star  icon on the clip to see the list of applied filters and tools.
2. In the list, select the filter that you don't want.
3. Click Remove.

Special effects
With special effects, you can further enhance your videos and images to make your movie a masterpiece. You can find these enhancements and
special effects in the left sidebar, or by clicking the More button.

Zoom
With the Zoom tool, you can create a panning or zooming effect. Choose a zooming mode and then set the zoom target using the frame in the
player and click Apply.
Learn more

Zooming in, zooming out, and panning
Chroma key
Using the Chroma key tool, you can remove a color from an entire video and replace the background with any other video or photo.
Learn more



 

 

Replacing a green background with the Chroma Key effect.
Highlight and conceal
Use this tool to blur or darken a part of the video. This way you can hide certain objects, like license plates or other private information, or highlight
things you want to show!
Learn more

Left to right: conceal with pixels, matte conceal, blur highlight, matte highlight
 
Stabilizing videos
Use the stabilization tool to remove camera shake from your footage.
Learn more

Before and after stabilizing
Pan and zoom

Using the Pan and Zoom tool, you can control camera movement using two keyframes. Set the beginning zoom and the end zoom using the
frames in the player, and the camera will smoothly move from one frame to the other.
 
Step 1: Open the Pan and Zoom tool
1. On the Timeline, select the clip that you want to zoom.
2. On the left sidebar, click the Pan and Zoom button.
Tip: If you can't see Pan and Zoom button, maximize the window, or click the More button at the bottom and select Pan and Zoom from the pop-
up list.

Step 2: Add pan or zoom keyframes
1. On the Timeline, place the position marker to where you want the zooming to begin.
2. Select one of the zooming methods: Zoom in, Zoom out, or Pan.
Tip: To see how an effect works, select it and click Preview.
3. Click Add.



 

 

This will add two zoom keyframes to the clip. Using these keyframes, you can set up when the camera moves from one point to the other. The
camera will move between these two keyframes.

Step 3: Set up the zoom frames
Now, you can set the zoom level for each keyframe using the frame in the player, and the camera will smoothly move from one frame to the
other.
 
1. To change the starting keyframe, double-click the first point on the clip. Then, use the frame in the player to set the zoom level for the starting
point of the camera movement. 
 
2. To change the ending keyframe, double-click the second point on the clip. Then, use the frame in the player to set the zoom level for the ending
point of the camera movement.

Step 4: Change the keyframe time
•  To change the length of the zoom effect, hold your mouse pointer over a keyframe and move it left or right.
 
•  To move the zooming effect without changing its length or other settings, hold your mouse pointer over the arrow and move it along the clip.
 
Step 5: Add more zooming (optional)
If you want to add more camera movements, repeat steps 2-4 to combine other camera movements in one clip. For example, you can zoom in
on an object, pan across the frame with the same zoom level, and then zoom back out to 100%.

 
Removing zoom
To remove a pan or zoom effect, right-click a keyframe and select Remove All Keyframes to clear all zoom effects from the clip. To remove just
the selected keyframe, select Remove Keyframe.



 

 

Highlight and conceal
Using the Highlight and Conceal tool, you can control the focus in the frame, and blur or darken parts of the video.

Step 1: Open the Highlight and Conceal tool
1. On the Timeline, select the clip that you want to edit.
2. On the left sidebar, click the Highlight and Conceal button. The tool's options will open, and a frame will appear in the player.
Tip: If you don't see Highlight and Conceal button, click the More button at the bottom, and choose Highlight and Conceal from the pop-up list.

Step 2: Set up the mask
1. In the Highlight and Conceal tool, open the box and choose Conceal if you want to hide an object, and Highlight if you want to bring attention
to the object.

2. Choose a shape for the mask: you can use a rectangle or an ellipse.
 
3. Choose a masking effect: blur, matte (black cover-up) or pixels. Use the options below to fine-tune the mask:
•  Opacity – makes the mask more transparent (for matte and blur)
•  Feathering – makes the edges of the mask softer (for matte and blur)
•  Size – changes the size of the pixels (for pixel masks only)
•  Outline – adds a white outline around the mask.

4. In the player, drag the corners of the mask to change its size and shape, and drag by the center of the mask to move it on top of the object.



 

 

Step 3: Add more masks (optional)
If you want to cover up or highlight more than one object, click Add Mask above the player to create another mask, and you can now set it up the
same way as the first.

Step 4: Apply the changes
When you're done, click Apply on the Highlight and Conceal panel to finalize the changes.

Chroma key
How to replace a video's background

The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.
 
Step 1: Add the foreground and background clips
Add the video or image clips that you want to use as the foreground and the background. For the foreground (the clip that you want to remove the
background from), use a clip with a bright, solid background that contrasts with the foreground objects.
 
Step 2: Create an overlay
1. Select the foreground video and move it up, onto the Overlay track.
2. Double-click the foreground video on the Overlay track. The overlay options will appear above the player.
3. To make the foreground video completely cover the background video, select the Cover overlay mode from the list above the player.
4. Click Apply.



 

 

Step 3: Open the Chroma Key tool
1. Select the foreground video on the Overlay track.
2. On the left sidebar, click the Chroma Key button. The Chroma Key options will appear.
Tip: If you don't see the Chroma Key button, click the More button and select Chroma Key in the pop-up list.

Step 4: Set up Chroma Key
1. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color you've
picked will be made transparent, and the underlying video will now be visible.
Tip: if nothing happens when you click on the player, click the color swatch in the Chroma Key options and then try again.

2. Use the Tolerance slider to set how many similar shades of the selected color should also be removed. Higher values will remove similar
colors to the one you've selected.
3. Use the Noise slider to determine how sharp the object's edges should be.
4. Use the Edges slider to determine how thick the object's edges should be.
5. Use the Opacity slider to set the transparency of the background.
6. Finally, click Apply to accept the changes.



 

 

Cropping the video
If the videos you're using for the foreground and background have different aspect ratios, you may end up with black bars or empty areas along
the edges after applying Chroma key. To fix this, crop the videos to the project's aspect ratio.
How to remove black bars
Cropping videos
 

Stabilizing video
If you're filming with a handheld camera, it's likely that there might be some unwanted camera shake visible on the video, especially if you walk or
move while filming.
 
Step 1: On the Timeline, select the clip you need to stabilize. Longer videos take more time to stabilize, so you may want to first cut the video
into smaller segments.
 
Step 2: On the left sidebar, click the Stabilization button.
Tip: if you don't see the Stabilization button, click the More button and select Stabilization from the pop-up list.

Step 3: Click Stabilize to open stabilization options. The Stabilization window will open.

Step 4: Set up stabilization with the following parameters depending on the video and the amount of shaking:
 
Accuracy: affects the analysis precision of the video. Higher accuracy yields the best results, but also takes more time.
 
Shaking: set how strongly the shaking is visible on the video.
 
If you need more advanced settings, click the arrow under the sliders.
 



 

 

Radius: when a video is stabilized, each object is adjusted using the pixels from the surrounding area. The radius affects how large that area will
be. Use a smaller value for more dynamic videos to avoid mixing objects together and to preserve more detail.
 
Smoothing: limits camera acceleration. Higher values work best for more or less static videos. Excessive smoothing may limit panning.
 
Edge Cropping: after compensating for motion, some distortion artefacts like blurred areas may appear around the edges.

•  None: the edges will remain as they are. Best results if there is little shaking on the video.
•  Fixed: the video is cropped to one size to cut off some of the edges.
•  Adaptive: whenever there is a lot of shaking, the video will zoom in so that the distorted edges are not shown.

Step 5: Click Stabilize to start processing the video. This may take a while depending on the length of your video and the selected parameters.

Step 6: After the video has been stabilized, you will see its preview in the player. If you're satisfied with the result, click Apply to replace the clip
on the Timeline with the stabilized video. If you didn't like the results, repeat steps 4 and 5.
 
Stabilized copies
A stabilized copy of the file will be created under User/Movies/Movavi Video Editor/Stabilized. This copy will be used in the project instead of the
original video. If you delete the stabilized copy, it will be replaced with the original video, and you will need to stabilize the clip again.
 
Filming tips
•  When shooting videos, try to rest the camera on something.
•  If possible, use a tripod. Some tripods are really small and can fit into your bag.
•  If you can't put down the camera, hold it with both hands and close to your body. This will minimize the shaking.
•  Try to move around less. If you have to move the camera, do it slowly.
•  Check your camera's settings to see if it has built-in stabilization.
 

Troubleshooting
Not enough disk space error
When a video is stabilized, Movavi Video Editor for Mac creates a stabilized copy of the video in a folder on your disk. By default, this folder is
User/Movies/Movavi Video Editor/Stabilized on your main disk drive. If you are running out of space on that drive, you can either free more space
and try again, or tell the program to save stabilized copies on another disk: 
1. Open the Settings menu and choose Preferences.
2. Switch to the Files tab.

3. Find the "Store stabilized videos in" box and click the button  on the right to choose a different folder on a drive where you have more
space.
4. Click OK to accept the changes. Now, try stabilizing the video again. 
 
Cannot access folder error
This error means that you've changed the folder where stabilized files are stored, and that folder's permissions prevent Movavi Video Editor for
Mac from creating files inside it. Try using a different folder for storing stabilized videos.

Fading effects
Making effects and filters fade in smoothly is possible using the overlay track.
 
Step 1: Copy the clip and paste it onto the Timeline.
 



 

 

Step 2: Drag the copy of the clip onto the overlay track above so that it's right above the original. Now you have two identical clips right on top
of each other. You might also want to mute the overlay clip.

Step 3: Double-click the clip on the overlay track and choose Cover mode in the panel above the player. Click Apply and the clip will cover the
entire frame.

Step 4: Now, apply the effects or filters you want to use onto the upper, visible clip.
Learn more: Applying filters

Step 5: With the overlay clip selected, click the Clip Properties button. There, use the Fade in and Fade out sliders to set the fading time. Here
you can also set Opacity if you want to reduce the effect's strength for the whole clip.



 

 

The clip with the effect will gradually appear and disappear, exposing the underlying original clip.
 

Working with audio
Add audio
To add music or other sounds to your project, click the Add Media Files button on the Import tab.

Learn more about adding audio:
Adding audio files | Recording audio | Extracting audio from video | Using built-in sounds

Audio tracks
When you add audio clips to your project, they will appear on one of the audio tracks at the bottom of the Timeline. There are two types of audio
track:
 
Linked audio track – each clip on this track is linked to a video clip on the main video track. This means that this clip will always stay
synchronized with this video.
 
Independent audio track – this is the standard video track, where audio clips such as background music will play independently from any other
tracks.
 
After you add the clips, you can rearrange them with your mouse and cut them just like video clips.

Learn more:
Audio tracks | Cutting audio | Looping audio

Volume
To change a clip's volume, click the Audio Properties button on the toolbar and set the necessary volume in the audio tools section above.

Learn more:



 

 

Volume levels | Volume curves | Muting clips
 
Audio properties and adjustments
To enhance and adjust the audio, click the Audio Properties button on the toolbar and scroll down in the audio tools section above.

Learn more:
Audio properties | Fading audio | Equalizer | Noise removal | Audio effects | Beat detection

 
Audio tracks

Audio in your project can be located on the video track as built-in audio, the linked audio track, or on the independent audio track. When you add
audio files to your project, they are first placed onto the independent audio track.

 Independent audio track
All new audio clips are added to the independent audio track. Audio clips on this track will play independently of any other tracks and will not
change when you edit other clips. This makes it suitable for background music.
 

 Linked audio track
Clips on the linked audio track are always linked to a clip on the main video track. This ensures that the clips stay in sync with the video even as
you edit your project and move or cut the clips. At first, this track is hidden until you link your first audio clip.
 
To link an audio clip:
1. Select the clip you want to link.
2. Drag it up, towards the video track.
3. A line will appear between the video and the audio clips. Place the audio clip on the linked audio track so that the line points to where it should
begin.



 

 

Now, the audio is linked with the video clip that it points to. If you cut or delete the video clip, its linked audio clips (as well as titles and overlay
clips) will also be cut or deleted.

 

 Built-in audio on the video track
If a video clip has sound, both the video and audio will be added to the video track. The built-in audio is always together with its video, unless you
decide to move or delete the audio.
 
•  To separate built-in audio from its video clip, click on just the audio ribbon under the video clip, and then drag this ribbon down onto an audio
track. You can still keep the audio synchronized with the video by placing it on the linked audio track.

• 
 
To remove built-in audio, click on the audio ribbon under the video clip and click the trash icon .

 
Waveforms
Each audio clip's sound is represented as a waveform on the clip's ribbon. Waveforms can help you easily find the quietest and loudest parts of
the clip.

Playing audio synchronously
If you want two audio clips to play at the same time, simply drag one clip underneath the other. This way, you can have as many sub-tracks as
you want. With music, you can use this to create a crossfade effect when you join songs: align the beginning of the second song with the end of
the first song to make them joined almost seamlessly.

The end of the first audio clip will be played with the beginning of the second clip.
Problem: My audio clip appears on the video track
Solution: Some audio files contain album art, which may sometimes be recognized as the video stream. Therefore, these files may be placed on
the video track. In that case, drag the audio clip down onto the audio track, and delete the album art from the video track if you do not need it.
 
 

Adding audio
You can add audio files in much the same way as you add video files.
 
Add files from your hard drive
1. In the Import tab, click Add Media Files to browse for audio files on your computer.
2. A Finder dialog box will open. Choose the files that you want to use.
3. Click Open. The files will be added onto the audio track of the Timeline.

Use sample audio clips
If you don't have any suitable audio files, you can use free sample audio clips[1] from the Movavi Video Editor for Mac audio collection.
1. On the Import tab, click Sample audio to open the free stock audio collection.
2. Click on a clip to hear it. When you've picked a clip, drag it onto the audio track of the Timeline.
Learn more about sounds



 

 

Record audio
1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the toolbar to open recording options.
4. Set up your recording device and volume.
5. Click Start Recording and record the audio. When you're finished, click Stop Recording. You'll find your new recording on the Timeline.
Learn more about audio recording

Set start time for audio clips
After you've added the audio files, they will appear on the audio track of the Timeline as a blue line with a music note icon:

By default, the audio clips will be added to the very beginning of the audio track on the Timeline. To change when the audio clip starts playing,
drag it along the Timeline.
Learn about audio tracks

Extracting audio from videos
If you want to use a soundtrack from a movie, you can extract it from a video file and use it in your project. 
 
Step 1: Open video file
On the Import tab, click Add Media Files and choose the video that contains the music you want. The file will be added to the video track of the
Timeline.



 

 

Step 2: Trim video
If you don't need the whole video's soundtrack, you can trim away the parts of the video you won't need. It's easier to do this with the video file, as
the video can help you visually find the beginning and end of the fragment you need.
1. Select the video you want to trim.
2. Move the position marker to the beginning of the fragment you want to keep and click the Split button on the toolbar (scissors). You've just cut
off the beginning of the video. 
3. Now, select the second clip and move the position marker to the end of the fragment you need. Click the Split button again, and the fragment
will now be in a separate clip.
4. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.

Step 3: Extract the video
The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down onto
the audio track. If you don't need the video clip anymore, go ahead and delete it.

You can now work on the extracted audio clip.
 
Step 4: Save the audio (optional)
If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button. The export window will open.
2. In the Export window, switch to the Save Only Audio tab.
3. Select an audio format that you want to save the audio file in.
4. The Save to field shows where on the disk the file will be saved. To change that folder, click Browse and select a new folder.
5. Finally, click Start to save the audio file.

Please respect copyright laws and stay within the boundaries of fair use of copyrighted materials.
Using sounds

You can make your movies more expressive using the built-in sound samples.
 
Step 1: Click the Import button to open the Import tab.
 
Step 2: On the left part of the Import tab, click Sounds to open the sound collection.



 

 

Step 3: Click on a sound to play it and pick a sound you like. Drag the sound onto the audio track of the Timeline.

Step 4: (optional) To synchronize the sound with a video clip:
1. Select the sound on the Timeline and drag it up towards the video track.
2. The linked audio track will appear, and a blue line will connect the sound clip to the video track.
3. Adjust the position of the sound clip on the linked audio track so that the line points to where the sound should begin.

Cutting audio
 

Splitting audio
1. Select the clip that you want to split.
2. Move the position marker to the point where you want to split the clip.
3. Click the Split button on the toolbar (scissors icon).
The audio clip will now be split into two parts.

Trimming audio
To trim an audio clip from the beginning or from the end, hold your mouse pointer over the left or right edge of the clip and drag it towards the
center. The length of the audio clip on the Timeline reflects the length of the sound.

Cutting out parts



 

 

Let's say you want to cut out a fragment from the middle of an audio clip.
1. Place the position marker onto the beginning of the unwanted fragment and click the Split button.
2. Place the position marker onto the end of the unwanted fragment and click the Split button.
3. The fragment is now separated into a clip of its own. Select that clip and click the Remove button. The clip will be removed, and the remaining
clips will be moved up to close the gap.

For more precise navigation:
•  Use the arrow keys to jump to the beginning of the previous or next clip on the Timeline.
•  Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second
forward or back.
•  Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: ⇧⇧⇧ and ⇧⇧⇧.
•  Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the ⇧⇧ and ⇧⇧ keyboard shortcuts.

Volume levels
Changing volume levels works the same way for video and audio clips:
 
Step 1: On the Timeline, select the clip that you want to edit. This can be a video or an audio clip on any track.
 
Step 2: Click the Audio Properties button to open the tools for the selected clip.
 
Step 3: Drag the Volume slider to set the necessary level, where 100% is the original volume.

•  To mute the clip, click the Mute  button on the right.
•  If parts of the audio clip are too quiet, select the Normalize option to increase their volume.

Playback volume
Only for previewing
If you need to temporarily change the volume of playback in the editor, without changing the project's volume, click the speaker icon in the
preview area and set the necessary volume level. Please note that this will only affect the volume while previewing the project in the Editor, and
will not affect the output file.

Volume curves
If you need more advanced volume control, you can use volume curves on the Timeline to set the volume for precise parts of any audio clip.
Learn more about volume curves

Audio clip with a volume curve
Volume curves

With volume curves, you can control the volume for each part of the clip and smoothly increase or decrease the volume.

Each clip has its own volume curve that starts out at 100% volume for the entire clip, and two points at its beginning and at the end. The white line
on the image below is the volume curve before you add any points.



 

 

Step 1: Set the base level
Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

Step 2: Add a volume point
Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume Point
from the pop-up menu. Next, drag the audio point to the necessary volume level. You'll notice that the surrounding parts also move with the point
to make the transition smoother.
 
Make as many points as you need for each part of the clip where you'd like a peak or a drop in volume.

Step 3: Manage the volume for a part of the clip
To set the volume level for a part of the clip, you'll need at least two points. Create a point at the beginning and at the end of the fragment:

Click and drag the white line between two points to change the volume level for this fragment. 
 
Step 4: Transitions
When you drag a volume point or a fragment, the parts of the curve to the left and right will also move with it.

However, this affects only the closest parts of the curve. To get more control over the behavior of the curve, create more volume points. This way,
only the adjacent parts will be adjusted, leaving the rest of the curve as it was.

Audio properties
To open the properties for any audio, including built-in audio on the video track, select the clip on the Timeline and click the Audio Properties
button on the toolbar.

The Tools panel will open on the Audio tab, where you can edit the following:
 
Volume — Sets the volume of the clip.
 
Normalize — Makes the quiet parts louder.
 
Speed — Makes the audio play faster or slower.
Changing the speed of built-in audio will also affect its video.
 
Reverse — Plays the audio backwards.
Reversing built-in audio will also reverse the video.
 
Fade in — The audio fades in from complete silence to full volume in the time you set.
Fading built-in audio will also fade the video.
 
Fade out — The audio fades out from full volume to complete silence in the time you set.



 

 

Fading built-in audio will also fade the video.

See also:
Video properties
Equalizer
Volume curves

Fading audio
In the editing tools, you can add smooth fades to the beginning or the end of a clip and create a crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Click the Audio Properties button on the toolbar. The clip properties will open in the Tools panel above.

Step 3: Set the fade length using the sliders on the Audio tab.
 
Fade in – how long in seconds it will take to fade in from silence to full volume at the beginning of the clip.
 
Fade out – how long in seconds it will take to fade out from full volume to silence at the end of the clip.

Equalizer
Using the equalizer, you can boost or reduce the levels of specific frequencies.
 
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Equalizer.

Step 3: Choose an equalizer preset (optional)



 

 

Step 4: Drag the volume bars to adjust the frequencies to the necessary level.

Noise removal
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Noise Removal.

Step 3: Use the Noise suppression slider to set the amount of noise you want to remove.
•  Start with low levels and listen to the audio to check if the noise is gone.
•  Don't set the noise suppression too high if there isn't much noise because it can start muting other sounds.

 
Audio effects

Audio effects can transform the sound of an audio clip.



 

 

 
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Audio Effects.

Step 3: Click the box in the Audio Effects section and choose an audio effect you like.

Removing effects
When you've applied an audio effect to a clip, a star icon will appear on it:

Click on the star to show a list of applied effects. Then, select the effect you don't want and click Remove.

See also:
Using sounds
Audio properties

Beat detection
To make your movie or slideshow more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and then
adjust your movie to the beat of the music.
 
Step 1: On the Timeline, select the music that you want to detect beats for.
 
Step 2:  Click the Audio Properties button to open the audio tools. Then, scroll down and click Beat Detection.



 

 

Step 3: In the Beat Detection tool, click Detect Beats. The program will analyze the music and place beat markers on the Timeline.

Step 4: (optional) After the beat markers have been placed, you can modify their tempo. Use the Min time between beat markers slider to make
the beat slower or faster.

Step 5: Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.
 
Removing beat markers
•  To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select Remove Beats from the pop-up menu.
 
•  To remove all beat markers from your project, right-click the Timeline ruler and select Remove All Beats from the pop-up menu.

Looping audio
If the music file you've selected doesn't go all the way until the end of your movie, you can loop the audio and have the file play over again until the
end of the video.
 
Step 1: Copy the audio clip. To do that, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu, or use the ⇧C keys.
 
Step 2: Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until the
audio is as long as the video.
 
Step 3: Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip, and
drag the edge to the left, until the end of the audio clip is right under the end of the video clip.

Hint: if you're making a slideshow, try using the Slideshow Wizard. There, the audio is automatically trimmed or looped to fit your project.
 



 

 

Adding transitions
Transitions are short animations that use geometric shapes and transparency to connect two clips in a creative way.
 
Add a transition
1. Click the Transitions button in the upper left-hand corner of the window to open the list of all transitions.

2. In the list of transitions, pick a style you like and drag-and-drop its icon between to clips on the Timeline.

A transition icon will appear between the two clips.

Change transition length
By default, each transition will be set at 2 seconds long. To change the transition length:
1. Right-click on the transition you want to edit and choose Transition Properties from the pop-up menu. 
2. In the Transition Properties window, enter the new transition length in the Duration field. The format is hours:minutes:seconds:milliseconds.
If you want all transitions that are currently in the project to have the same length, select the Set this duration for all transitions option.
3. Click OK to apply the changes.

 
Add transitions to all clips



 

 

You can automatically add transitions between all clips in your movie in just a few steps:
1. Click the slideshow button on the toolbar. The Create Slideshow dialog box will open.
2. In the Create Slideshow dialog box, select a transition style that you want to use for all clips. If you want to use different transitions, use the
Random Transitions option in the list of transitions.
3. In the Transition duration box, enter the length that you want to set for all transitions. A transition cannot be longer than the shortest clip in
your project.
4. Click OK to accept the changes.
Creating Slideshows

Remove a transition
To remove a transition from your video, right-click the transition on the Timeline and choose Remove Transition from the pop-up menu. If you
want to delete all the transitions in your video, choose Remove All Transitions.

Adding titles
Adding text titles to your movie allows you to express your thoughts and supplement the audio with subtitles.
 
Step 1: Go to the Titles tab
On the left-hand side of the window, click the Titles button to view the titles collection. Click on a title style's thumbnail to preview its looks in the
player and choose the titles you want to use.

Step 2: Add a title clip
To add titles to your project, pick a title style you like and drag its thumbnail onto the title track of the Timeline, right above the video track. A title
track will appear above the video track: drop the titles here, onto the time where you want them to appear. The titles will appear as a purple ribbon
on the Timeline.
 
The beginning of each title clip is linked to a corresponding video clip on the video track. This way, whenever you move or edit the video clip, its
titles will always stay in sync.



 

 

If you already have a titles clip on the Timeline, you can add another clip onto the same timeframe to make them play simultaneously: simply
place one title clip under another.
 
Step 3: Edit titles
When you've added a title clip, it will start out with the default text and looks. Double-click the title's ribbon on the Timeline to show editing options
in the player.
 
Title clip properties

Click the cogwheel icon  at the top of the editing panel to see title clip properties. Here, you can change the duration of the titles and
animation speed (how fast they will appear or disappear).
 
Editing text
1. In the preview, click on the text box you want to edit to select it.
 
2. Enter the new text.

3. Click the Font properties  button and select the font style, size, and alignment options for the selected text.

4. Click the Color properties  button and choose a color for the text, and the outline's width and color.
 
5. Drag the text box to where you want to see it on the video.
 
Editing decoration elements
Some titles come with frames, ribbons, and other decorations. To change their color, select the decoration element you want to edit and click the

Color properties  button. Then, click the Decorations color palette and choose the new color.
 
Finally, click Apply to exit editing mode.

See also:
Adding callouts
Adding a timer
Title and callout track

Adding a timer



 

 

Step 1: Open the Titles tab
Click the Titles button on the left sidebar to open the list of available text styles.

Step 2: Add Timer titles
1. Find the "Timer" title style. Use the search bar or click the Basic group to filter the styles.
2. Drag the Timer titles onto the title track of the Timeline. Move the clip along the Timeline until its beginning is where the titles should appear. To
change the length of the timer, drag at the edges of the clip.

Step 3: Edit the timer
1. Double-click the timer clip on the Timeline to edit it. A properties panel will appear over the player.

2. On the Clip properties tab , set the duration and the format of the timer. The format determines which units of time are visible on the
timer: hours (hh), minutes (mm), seconds (ss), and milliseconds (zzz).

3. On the Font properties tab , choose the font and style of the numbers.

4. On the Color properties tab , set the color of the numbers and the background color. To make the background transparent, click the
background color square and set Opacity to 0%.

5. On the Timer tab , enter the starting time into the From box. If you want the timer to count backwards, select the Countdown option.
 
6. In the player, drag the Timer to the necessary location on screen.
 
7. Finally, click Apply to exit editing mode.



 

 

 
Title and callout track

Both titles and callouts appear on the Title track at the very top of the Timeline. Title and callout clips appear on the Timeline as purple ribbons.
You can also place title clips on the main video track, if you want them to appear on a black background.

A clip's length and position relative to the Timeline ruler shows when the titles will appear on the video.
 
Time
To change when the titles appear, drag them along the Timeline and place the beginning of the ribbon at the time when the titles should appear.
 
Length
To change the duration of the titles, hold your mouse pointer over the left or right edge of the clip and drag it to change the length.
 
Title synchronization
Every title and callout clip is linked to a clip on the main video track. A purple line connects the title or callout clip and the video clip. This allows you
to freely edit your videos without losing sync with the titles.
•  When you move the main video clip, any connected titles or callouts will be moved with it.
•  If you delete the main video clip, any connected titles or callouts will be deleted with it.
•  If you split the main video clip, any connected titles or callouts will also be split in the same position.
•  To link the titles or callouts to a different clip, drag the purple ribbon on the timeline over the clip you want to link it with.
 
Overlapping titles and callouts
You can play several titles and callouts simultaneously by overlapping them on the title track. Simply move one clip under another and they will
both show on screen at the designated time. On screen, the clips will be layered in the same order as they are on the Timeline.

The exclamation mark icon covers a part of the text bubble because its clip is at the top of the Timeline.
 

Saving custom titles
After you've set up titles to look the way you want, you can save that style and use it in your projects.
 
Step 1: Just like you usually edit titles, double-click the title clip and choose the font, color, and other options.
 
Step 2: Click the Save icon at the top of the title editing panel on top of the player.
 
Step 3: Enter a name for your titles and click Save.
 
The new title style will appear under the My titles group.



 

 

Adding callouts
Using callouts, you can annotate your video with arrows, speech bubbles, icons, and other shapes.

Step 1: Open the Callouts tab
Click the Callouts button on the left sidebar to open the shape collection.
•  Click on a callout icon to see it in action.
•  Callouts are grouped into categories on the left. Use these to find the shapes you need.
•  If you're looking for a specific callout, type its name into the search box under the list of groups.

Step 2: Add callout clip
When you find a style you like, drag it onto the title track at the very top of the Timeline. Place the beginning of the clip where you want the callout
to start appearing. Drag the edges of the callout clip to change its duration.



 

 

Note that the clip is linked to the corresponding clip on the main video track with a purple line. This means that the callout clip is synchronized
with the video: when you move or cut the video clip, the callout clip will follow without losing sync.
 
Step 3: Edit the callout
Double-click the callout clip. An editing panel will appear in the player. If the callout consists of several elements, for example, text and a shape or
two shapes, make sure to select the one you want to edit.

 
Position
In the player, drag the callout to where you want it to appear on screen.
 
Clip properties
•  On the editing panel, set the animation speed for the element to change how fast it appears on screen.
•  To change the callout's duration, enter it into the Duration box or drag the edge of the callout clip on the Timeline.
 
Colors

Click the Color properties icon  and choose the color and outline for the selected element.
 
Text
•  If the callout has text, double-click on the text box and enter the new text.

• 
 
Click the Text properties icon  and choose the new font, size and style for the callout text.

 
When you're done, click Apply to accept the changes and exit editing mode.

See also:
Title and callout track
Adding titles

Exporting videos
When you're done with your project, you'll need to export it as a media file to be able to play it back in media players, mobile devices, and so on.
This section will guide you through the process of exporting your project to a popular video format. If you want to find out more about other ways
of saving videos, see the following guides:
Saving only audio
Saving videos for devices
Saving videos for TVs
Uploading videos online
 



 

 

Step 1: Open the Export window
To start saving the video, click the Export button in the bottom right-hand corner of the Editor. The export settings window will open.

Step 2: Choose a format
Open the list at the top of the window and choose a format for saving the video in.  Some formats allow you to choose which video codec you
want to use, and some allow you to save 60 FPS video*.
*The video file will have a frame rate of 60 FPS only if the original video files used in the projects had a frame rate of 60 FPS and above.
 
If you don't know which format to choose, try using MP4 with the H.264 codec. The MP4 format is supported by most platforms and operating
systems.

Step 3: Check your project settings
When saving standard video, it will be exported with the same settings that were set for the project. This way, the output video will appear exactly

as you've seen it in the preview area. If you want to change the resolution, aspect ratio, or other settings, click the pencil icon  to view and edit
the project settings.
 
The Estimated File Size field shows how much disc space your file will require after saving. If the file size is too large, you can set a lower
resolution in the Project Settings. At lower resolutions, the file will be significantly smaller, however the video will lose some quality due to the
limitations of digital data compression. When changing resolutions, we recommend that you keep the same aspect ratio to avoid black bars
around the video or other unwanted distortions.
Learn more about project settings

Step 4: Select quality (optional)
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.



 

 

Step 5: Choose a destination folder
Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in
the preferences. To set a different folder, click the Browse button and choose the folder in the Finder window, or enter the path manually into the
box. Name your video in the File Name field: the project's name will be filled in for you by default.

Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.

Export only audio
This section will guide you through exporting just the audio track of your project.
 
Step 1: Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

Step 2: At the top of the Export window you will find a number of tabs. Click on the Save Only Audio tab



 

 

Step 3: Open the list at the top of the tab and select the format you'd like to save the audio in.
 
While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high audio
quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the original files: due
to data compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC audio, and vice versa –
high quality files may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.

When saving audio from your project, the audio file will retain the same sample rate and channel settings as you have set for your project. The
audio bitrate will be determined from the quality of the original files and from the maximum bitrate for the selected format (for example, MP3 is
limited to 320 Kbps, while FLAC bitrate is not limited).
 
Step 4: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in
the preferences. To set a different folder, click the Browse button and choose the folder in the Finder window, or enter the path manually into the
box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 5: Click the Start button to begin processing the video file. This may take up to a few minutes. 

Uploading videos online
After you finish your video, you can share it to YouTube right from the export window.
 
Step 1: Open the Export window
1. Click the Export button to open the exporting window.
2. Switch to the Upload online tab.



 

 

Step 2: Sign in to your account
1. Click Sign in. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Video Editor for Mac upload videos.

Step 3: Choose a resolution
In the Export window, open the Resolution list and choose a resolution that suits your project.
•  For best results, choose a resolution that is equal to or less than the height of your project. You can find the resolution of the project at the
bottom of the main window, next to Project settings. For example, if your project is 1280x720, choose the 720p resolution.
•  This resolution will be the highest available quality available for your video. Lower resolutions will be generated automatically by the website.

Step 4: Fill in the details
1. Fill in the title and description for your video.
2. Add some tags to help users find videos by relevant topics. Separate tags with commas and add a number sign (⇧) before each one.
3. Choose a category to help viewers find relevant content.
4. Open the Privacy box and choose who you want to see the video:
•  Private – only you can see the video.
•  Unlisted – the video will not appear for other people unless you give them the link.
•  Public – anyone can access the video.



 

 

Step 5: Save and upload the video
1. Before uploading, the video will be saved as a file on your computer. To change where the video file is stored, click Browse and select a folder.
2. Check the length and size of the video. YouTube allows users to upload videos up to 15 minutes. To upload longer videos, you need to verify
your account.
YouTube help – increasing your upload limit 
3. Click Start to begin saving and uploading the video.

Export for TVs
This guide will help you export your video project for playing on Smart TVs.
 
Step 1: In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

Step 2: At the top of the Export window, you will find a number of tabs for saving different kinds of media. Click the For TVs tab.

https://support.google.com/youtube/answer/71673?hl=en


 

 

Step 3: Open the list at the top and choose your TV brand and the necessary resolution. If your TV is not on the list, choose Other 1080p TVs.

Step 4: Set export quality (optional)
Project settings: If you've been using the default project settings, your video's resolution is now 720p. To avoid losing quality when saving to

a larger resolution, click the pencil icon  and edit the project settings. There, choose the 1920x1080 resolution for 1080p HDTVs, and the
3840x2160 resolution for 4K Ultra HD TVs.
 
Quality: If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher
bitrate. This will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a
small file size.

Step 5: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in
the preferences. To set a different folder, click the Browse button and choose the folder in the Finder window, or enter the path manually into the
box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 6: Click the Start button to begin processing the video file. This may take up to a few minutes.

Export for devices
This guide will help you export your video project for playing on mobile phones, tablets, TVs, and other devices.
 
Step 1: In the bottom right hand corner of the Editor, click the Export button to open the export settings window.



 

 

Step 2: At the top of the Export window, you will find a number of tabs for saving different kinds of media. Choose the necessary tab depending
on your type of device:
•  For Apple Devices: to save the video for devices made by Apple, including iPhones, iPads, iPods and Apple TV.
•  For Android Devices: to save the video for smartphones, tablets, and other devices running the Android operating system.
•  For Other Devices: to save the video for devices running neither iOS nor Android. These include Blackberry and Nokia smartphones, classic
mobile phones with 3GP and 3G2 video, Xbox, PlayStation, Zune, and others.

Step 3: Once you've opened the necessary tab, open the list at the top and select your device or manufacturer from the list.
 
Note the Export Settings information, where you can view the properties for the output file. Due to the limitations of some devices, the video
resolution, audio quality, and other properties may be changed to adhere to the requirements of the selected device. Estimated File Size will give
you a rough estimate of how much disk space the file will occupy, which may be important if your device is running out of memory.

Step 4: Set export quality (optional).
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.

Step 5: Name your file and choose a destination folder.



 

 

In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in
the preferences. To set a different folder, click the Browse button and choose the folder in the Finder window, or enter the path manually into the
box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 6: Click the Start button to begin processing the video file. This may take up to a few minutes.

Program preferences

To open the preferences, click the Movavi Video Editor application menu and select Preferences.
 
The Preferences window will open. The preferences are organized into tabs. Click on a tab to open the relevant options.

When you're done, click OK to close the window and apply the preferences.

See also:
General preferences
File preferences
Sharing preferences

General preferences
Interface Language – to change the interface language, simply select the necessary language from the list and click OK to apply the changes.
 
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates within your version are
absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.
 
Show startup window when creating new project – with this option enabled, you will be prompted to select settings for the new project on
startup and when creating new projects. You can choose the project's aspect ratio and other settings, as well as open an existing project.
 
Send anonymous usage stats to Movavi – checking this box will allow Movavi Video Editor for Mac to send usage statistics to our development
team, enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data sent by
Movavi Video Converter contains no personal information, will not be disclosed to third parties and will be used for software improvement
purposes only.
Learn more about how we use the statistics
Read our Privacy Policy
 
Play notification sound when exporting is finished – when saving a project as a media file, you'll be notified as soon as the process is
completed.

http://www.movavi.com/mip.html
http://www.movavi.com/privacy.html


 

 

File preferences
On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different location.

 
Save project files to – this folder will by offered by default when saving and opening projects. This folder will also store any autosave files for
new projects. You can use the autosave file to restore your work in case of an error or force close.
 
Save output videos to – this folder will be offered by default when exporting media files.
 
Store audio recordings in – the audio clips that you record in the Editor will be stored as audio files in this folder. Tip: if you delete these audio
files, the audio recordings in the project will also be unavailable.
 
Store stabilized videos in – when you stabilize a video, a stabilized copy of the original will be created in this folder and used instead of the
original. Tip: don't delete these files while you are working on the project, or you'll have to stabilize the files again.

Changing where the files are stored
Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in another
way.

1. Click the button with three dots  next to the folder you want to change.
 
2. A Finder dialog box will open. Choose the folder you want to save the files to.
 
3. Click Select Folder to use this folder. 

Sharing preferences
On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.
 
To sign in:
1. Click Sign In. The authentication page will open in the browser.



 

 

2. Sign in to your account.
3. On the next page, allow Movavi Video Editor for Mac to upload videos to your account.

4. Return to Movavi Video Editor for Mac. Your name will be shown in the Preferences window.
 
To sign out or use a different account:
Click Sign Out. After this, you will need to sign in again to upload videos.

Help and support
Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.



 

 

How to reach us
By e-mail: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!
 
If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information
about your system will allow us to help you faster.

 
Frequently Asked Questions
How to remove the trial watermark
What are the system requirements for using Movavi Video Editor for Mac?
What formats can I save my movie in?
More frequently asked questions
 
 

System requirements
Note that Movavi Video Editor for Mac may also run on slower machines, however, we cannot guarantee stable performance if the minimum
requirements are not met.
 
  Minimum system requirements Recommended configuration
Operating system Mac OS® 10.6.8 or higher  
Processor 64-bit Intel processor  
Display resolution 1280x800 screen resolution, 32-bit color  
RAM 256 MB RAM 1 GB RAM
Free disk space 200 MB for installation, 500 MB for proper

operation
1 GB for smooth operation

Other Administrator permissions are required for installation
 
 

Supported formats
Here you can view the list of formats and codecs supported by Movavi Video Editor for Mac.

 
 

Video Formats
 

Supported Codecs

Read / Write H.263
3GPP (.3gp), 3GPP2 (.3g2)

Read Only H.264, MPEG-4
Advanced Streaming Format (.asf) Read Only MPEG-4, VC-1, WMV V7

Read / Write H.264, MPEG-4
Audio Video Interleave (.avi) Read Only H.263, MJPEG, DivX, Xvid, DV, Cinepack, Fraps,

TechSmith, Uncompressed
DivX Video (.divx) Read Only DivX

Read / Write H.264
Flash (.flv)

Read Only FLV1, H.263, Flash Screen Video
Read / Write FLV1

Flash (.swf)
Read Only MJPEG

HD-видео (.m2ts, .mkv, .mov, .mp4, .mpg, .wmv) Read / Write MPEG-2, MPEG-4, H.264, WMV V8

HD-видео (.m2t, .mts, .ts, .wmv) Read Only MPEG-2, MPEG-4, H.264, AVCHD,WMV 9, WMV
9 Advanced profile

Read / Write H.264
Matroska (.mkv)

Read Only MPEG-4, MJPEG, Theora, DV, Uncompressed
MPEG Transport Stream (.m2ts) Read / Write H.264
MPEG Transport Stream (.ts, .mts, .m2t) Read Only MPEG-2, H.264
MPEG (.mpg) Read / Write MPEG-1, MPEG-2
MPEG (.mpeg, .mpe, .m1v, .mod, .tod) Read Only MPEG-1, MPEG-2, H.264

Read / Write MPEG-4, H.264
MPEG-4 (.mp4)

Read Only H.263, MJPEG, ProRes
MPEG-4 (.m4v) Read Only MPEG-4, H.264, H.263, MJPEG, ProRes
MXF – Material eXchange Format (.mxf) Read Only MPEG-2, DV

Read / Write Theora
OGV – Ogg Video (.ogv)

Read Only MPEG-4
Read / Write H.264

QuickTime (.mov) Read Only MPEG-4, AIC, MJPEG, ProRes, Sorenson 1/3,
PNG

QuickTime (.qt) Read Only H.264, MPEG-4, AIC, MJPEG, ProRes, Sorenson
1/3

RM – RealMedia (.rm, .rmvb) Read Only Real Video 2/3/4, Cooker
Read / Write VP8

WebM (.webm)
Read Only VP7, VP9

mailto:support@movavi.com
https://www.movavi.com/support/contact.html
http://www.movavi.com/support/


 

 

Read / Write WMV V8
WMV – Windows Media Video (.wmv) Read Only WMV V7, WMV 9, WMV 9 Screen,WMV 9

Advanced profile, MPEG-4,WMV 9.1 Image V2
WTV – Windows Recorded TV Show (.wtv) Read Only H.264, MPEG-2

 
Audio Formats

 
Supported Codecs

AAC – Advanced Audio Coding (.aac) Read / Write AAC
AMR – Adaptive Multi-Rate audio codec
(.amr, .3ga)

Read Only AMR

AIFF – Audio Interchange File Format (.aif,.aiff) Read Only Uncompressed
APE – Monkey's Audio (.ape) Read Only Monkey's Audio
Au (.au, .snd) Read Only PCM
FLAC – Free Lossless Audio Codec (.flac) Read / Write FLAC
MP3 – MPEG-1/2 Audio Layer III (.mp3) Read / Write MP3
MPEG-4 (.m4a, .m4b) Read / Write AAC
MPEG-4 (.m4a, .m4b) Read Only AAC, PCM, ALAC
OGG – Ogg Audio (.ogg) Read / Write Vorbis

Read / Write PCMWAV – Waveform Audio File Format (.wav)
Read Only AAC, MP3

Read / Write WMA 9WMA – Windows Media Audio (.wma)
Read Only WMA Pro, WMA Voice

 
Image Formats

 
Supported Codecs

BMP (.bmp) Read Only BMP
DPX (.dpx) Read Only DPX
GIF (.gif) Read Only GIF
JPEG (.jpg. jpg, .jp2, .jls) Read Only MJPEG, JPEG2000, JPEGLS
Netpbm formats (.pgm, .pbm, .ppm, .pam) Read Only PGM, PBM, PPM, PAM, PGMYUV
PCX (.pcx) Read Only PCX
PNG (.png) Read Only PNG
PTX (.ptx) Read Only PTX
SGI (.sgi) Read Only SGI
TARGA (.tga) Read Only TARGA
XBM (.xbm) Read Only XBM
XWD (.xwd) Read Only XWD
 
You can view the full list of supported devices here.

Codec activation
Some video and audio codecs are patented by other companies, and it is required that new users activate the codecs they use to comply with
patent law.
 
1. When you open a media file or export your project with one of these codecs, you may see a Codec Activation message.
 
2. Select the Activate other codecs without asking box to activate all codecs automatically in the future. The codecs will be activated
automatically, but an Internet connection is still necessary.
 
3. Click Activate to complete the codec activation.
 
Codec could not be activated
If you see a codec activation error, make sure that you have a working Internet connection. Without Internet, the codecs cannot be activated even
if you've chosen to activate them automatically. After you've restored the network connection, please restart the application.
 
What kind of data is being sent?
The data we send does not contain any information that can personally identify you. We only receive information about which codecs were used.

Glossary
The following is a list of some terms that you may come across while working with video and audio. You won't need to know all of these to use
Movavi software, but if you want to learn more about the specifics of media file processing, you can start here.
General
Aspect Ratio
A video's aspect ratio is the ratio of a video's width to its height in pixels. The two most frequently used aspect ratios are 4:3 and 16:9. The former
is used by most analog television broadcasts, while the latter, also referred to as widescreen – in films, DVDs, and modern HD video. When the
aspect ratios of your screen and a video do not match, you may notice black bars on two sides of the video.
 
Container Format (Video Format)
A container format is a file format for storing video or audio files that contains video and audio data in separate streams, as well as any other
associated data, such as subtitle tracks and additional data about the file. You can think of a container format as a box that holds together all the
parts that make up a video file, as illustrated below. The container format is what you usually see when you work with video files: you can judge
which format your video is in by the file extension: *.mp4 corresponds to MP4 format, *.mkv to Matroska format, etc. Since a container format
only 'contains' different video streams, it is possible that two files with the same format may have video streams encoded with different codecs;
therefore, one file may easily play in a player, while the other will not.
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Codec
While a video file contains video and audio streams, these streams are in turn encoded using a video or audio codec that compresses the data.
You can think of a codec as a language: to play a video encoded with a certain codec, your player needs to be able to 'understand' how it was
encoded, so that it can decode or decipher the file. If your computer does not know how to decode a new codec, you can fix this by converting the
file to a different format or by installing a codec pack. However, please keep in mind that a lot of malware programs disguise themselves as codec
packs; you should only download codec packs directly from codec manufacturers or from trusted sources.
 
Bitrate
When referring to media, bitrate is the number of bits that is played back each second. The higher the bitrate, the more details that can be
conveyed with each second of the video or audio stream, and therefore, the higher the quality. There are two types of bitrate: constant bitrate
(CBR) and variable bitrate (VBR). Videos with constant bitrate, as you can probably guess from the name, have the same bitrate for each and
every frame of the video, no matter the complexity of the frame: simple frames, for example, those completely filled with black, have the same
number of bits as complex, colorful frames. This has a number of limitations, since the simple frames take up more bits than needed to convey
them, while complex frames are limited in quality. With variable bitrate, however, each frame is allotted only as many bits as it needs, without
limiting quality or wasting data. In most cases, we recommend that you use variable bitrate, however, you CBR is sometimes useful for streaming
media.
 
Frame Rate
The frame rate, or frames per second (FPS) is the number of video frames that is contained in a second of video. At low frame rates, you may
notice that the video is 'jittery', while higher frame rates produce a smooth high-quality video. Shooting videos at high frame rates (48 or 60 FPS)
requires more resources and disc space, but you can easily slow down a high-FPS video to produce a slow-motion effect without producing
visual stutter. The industry standard for cinema frame rate is 24 or 25 frames per second, which is perceived as comfortable to the human eye.
 
Interlaced Video, Deinterlacing Video
Video interlacing is a method used in traditional analogue video broadcasting that arose due to the limitations of early television. Each frame of
the video is split into half-frames, each frame containing even and odd rows consecutively. This allows to broadcast at double the frame rate,
producing a seemingly smoother video stream, while the eye does not notice the missing rows. However, on digital displays, interlaced video may
produce visible defects in the form of horizontal lines. Deinterlacing helps remove these defects using algorythms by merging the two half-frames
into one. Movavi Video Converter automatically deinterlaces output videos.
 
Remuxing
Many container formats support a number of common codecs, such as H.264, which can be stored in MP4, AVI, M2TS, MKV, MOV, and other
formats. When you convert a video that is encoded with a codec supported by both the input and output container formats, you can simply
transfer the video stream from one container format to another, without having to re-encode it. This process is called remuxing and it allows you
to save a lot of time, since video re-encoding is the longest part of the conversion process.
 
Resolution (Frame Size)
Resolution is the number of pixels that can fit inside the video frame. It is usually presented as "width x height" of the frame, for example,
1280x720 or 1920x1080. Sometimes, resolutions may also be referred to as "720p" or "1080p", by the number of pixels in a frame vertically. At
high resolutions, each frame is conveyed using more pixels, therefore allowing for more detail and higher quality, though taking up more disc
space. Whenever you convert a video to a lower resolution, you irretrievably lose some data, but if you convert a low-resolution video to HD, the
quality will stay the same. If you need to do so, however, we recommend that you use Upscale SD, DVD to HD presets in Movavi Video Converter,
as they use an algorythm that slightly improves video quality when converting to larger resolutions.
 
Sample Rate
Sample rate, measured in Hertz, determines how many samples of digital audio are recorded each second. Higher sample rates allow to record
higher quality audio, although the files will take up slightly more space. The recommended sample rate is 44100 Hz, which is the standard for
audio CDs, delivering sound that covers the full range of human hearing. To reduce file size, you can convert audio with lower sample rates, as
low as 22 kHz, but keep in mind the quality deterioration. 
 
Subtitles
A subtitle is text that appears on screen (usually at the bottom) that reproduces the video's dialogue or presents additional explanatory text and
sound effects. Subtitles are frequently used by people hard of hearing, language learners, and when an audio translation is unavailable. The
subtitles may be embedded within the video container file (also known as softsub), saved as a separate file in *.srt, *.ass, *.sub, and other subtitle
formats, or drawn over the video stream in such a way that they cannot be disabled (hardsub).
 
Video Formats
Audio Video Interleaved – AVI (*.avi)
AVI is a multimedia container format created by Microsoft in the early 1990s. AVI supports multiple video and audio codecs and can contain up
to 16 audio and 16 subtitle tracks. While support for AVI is widespread on all operating systems, it is steadily being replaced by more efficient
formats.
 
DivX (*.divx)
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DivX is a proprietary video format developed by DivX, Inc. Using its own codec, DivX allows for high compression rates while retaining high quality.
Sometimes the DivX codec is also used to encode video in AVI files. DivX is not supported by many media players, and requires a codec pack to
play. Movavi Video Editor can open DivX files, while Movavi Video Converter can open and convert DivX files to any other format.
 
Flash Video Format – FLV (*.flv)
Developed by Macromedia and currently owned by Adobe, FLV is frequently used for web video, as it is supported by most web browsers and is
accepted by most video sharing services and social networks. FLV can contain video encoded in Sorenson, FLV1, VP6 and H.264 codecs.
 
QuickTime – MOV (*.mov)
Developed by Apple, QuickTime is natively supported on Macs and iOS devices, so if you need to be sure that your video can be played on a Mac,
converting it to MOV would be a good idea. If you are preparing your files to also be played on a Windows computer, it's best to convert it to MP4,
as Windows computers need to download and install QuickTime from Apple's official website in order to play MOV videos.
 
SWF (*.swf)
Developed by Macromedia and currently owned by Adobe, SWF (formerly Shockwave Flash) is a video and graphics format related to Flash video
that can cointain video, animations, vector images, and other content. Usually created in proprietary Adobe software, SWF files are supported by
Adobe Flash Player and most web browsers, which makes it an efficient way of sharing content online due to the small file size.
 
WebM
WebM is a free open-source container format developed by Google. It primarily functions as a widespread web video format that can easily be
embedded in HTML5 video tags. WebM can contain video encoded in the free VP8 and VP9 video codecs and Vorbis audio.
 
Movavi File Formats
*.mep, *.mep2, *.mepx, *.meps
Used in Movavi Video Editor and Movavi Slideshow Creator to create editing projects that store file references, order of files on the timeline,
applied effects, and all other work on the project. Please note that projects created in older versions may not be compatible with the most recent
version of Movavi Video Editor.
 
*.mscproj, *.mrec
Used in Movavi Screen Capture to store temporary recording data, including the recording itself, as well as all settings used for the project.
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